
 Private Music Collection
Private Music Collection is a database to gather information about your Music Collection. 
Private Music Collection is meant for use at home. It can cointain up to 8000 records. 

You can use Private Music Collection together with MC Cover Builder. MC Cover Builder 
supports the database made by Private Music Collection. 

Working with Private Music Collection
· Records
· Searching a record
· Printing Records
· Exporting data
· Playing a CD
· Editting The Genrelist
· Options
· Known Problems

Other things you need to know
· License Information
· Registering
· Registration form
· Support

For questions or suggestions you can E-mail me at avdlogt@worldaccess.nl. Please use PMC 
in your subject line. For more details about updates and other applications check out my 
homepage http://www.tomb.demon.nl
. 



 The Database
Records
Creating a database
When you start Private Music Collection for the first time you'll have to create a new 
database. You can create a database by clicking the New button or selecting New from the 
menu option File. Choose the directory where you want to create the database and enter a 
filename using eight caracters. An extension is not needed. 

Opening a database
To open an excisting database, click on the Open button or select Open from the menu 
option File. Then select the diretory where the database is located and select the database 
or enter it's name. 
PMC can also open a database at startup. Make a new icon that starts PMC and add the 
filename with path as parameter. You don't need to enter an extension.

Closing a database
Before you can open or create a database you must close the database that is currently 
open. To close your database Click the Close button or select Close from the menu option 
File. 

PMC will close the database automaticly when you close PMC. Do never shut down the 
computer without closing the database. You may lose information or even loose the whole 
database. PMC will close all open files wyhen you close Windows.

General Information
The database of PMC uses three files: the index named <database>.dx, <database>.cd 
containing the general information about your albums and <database>.sg with information 
about the songs on the albums. Every record in the database will use approximately 2.5 kB 
diskspace. The space used changes with the number of songs entered. 

The images you can display in PMC are always displayed at a size of 125 x 125 pixels. A 
Windows BMP image of 125 x 125 pixels will use about 50 kB diskspace. You can save 
diskspace by using a small pallette or by saving the image at 100 x 100 pixels. 

PMC is able to recover a lot of accidents that can happen to your datbase. But in some cases
some of your records will be lost. Using PMC and your computer the way you should can 
save you a lot of troubles. I also want to advise you to keep a backup of the database.



 Records
Searching a record                Printing Records                Exporting data
Inserting a new record 
Before you can enter the data of a new record you'll have you click on the Insert button. 
Otherwise you will overwrite the data of the record currently displayed. When you click on 
the Insert button you get an empty screen. You must enter the fields Artist and Title before 
you can save the record. Before you can enter the songs you must enter the soundcarrier 
and the number of disks or tapes on the Details tab. 

The data you have entered will automaticly be saved when you start any action. You don't 
need to save anything. Just be sure to close PMC properly when you are finished!

Editing a record    
You can always change a record. Search the record you want to change and enter the field 
you want to change. 

Artist and Title
Before you can save the record, you must enter the name of the Artist and the Title of the 
album. You will start at the Artist field and when you are finished press <TAB> to move on to
Title.

Genre
You can select the Genre from the list in the combo box, but you can also enter it yourself. If 
you have registered your copy of PMC you are able to edit your Genre list in the menu 
Options. 

Producer/Composer
The field with the default name Producer can the used to enter the name of the producer or 
componist of the entire album. If you want to enter the composer just select that field name 
by pulling down the combobox and selecting Composer. You can enter the producer or 
composer of each different song in the songlist.

Label
The field Label is meant to enter the name of the record company that released this album.

Released
The field Released contains the date when the album is released. You cn enter the year, but 
also the excat date.

The tab Details

The data on this tab is used to manage some things in the database. So read the following 
carefully when you have some problems.

Soundcarrier
You can select one of the sound carriers by clicking on it. This field is required to enter the 
tracks or songs of on the album.

Number of Disks/Tapes
If you enter the number of disks or tapes you can specify on which Disks or tape a song is 
located. This field is required when you want to enter all songs.

Show Artist Of Song
When you have an album with songs from multiple atrists you can check the Show Artist Of 



Song box. Now you can enter the artist of each song in the songlist. This box can be checked
by default when you choose Show Artist Of Each Song in the Options menu. 

Show Producer/Composer
This field works the same way as Show Artist Of Song. You can also have it checked as 
default by selecting Show Producer Or Componist Of Each Song.

Load Track Times
By pressing on this button the times of all songs will be loaded from the Audio CD in the CD-
ROM player. Make sure you have the right CD inserted. When you have multiple CD's you will
be prompted for the next one. It is best to do this before you edit the Track List. When you 
have already entered the tracks the times will added to the song with the same track 
number. When the number of tracks is not the same as the number of tracks in the list you 
will get an error. This can also happen when there is a secret track on the CD.

The tab Additional

This tab contains some additional data, you don't need to enter it.

ID Number
This field can be used to enter your own code for the album or a location in your racks.

Obtained By
In this field you can enter from whow you got this album.

Lend To
When other people often borrow your CD's you can keep track of your CD's by entering here 
who has the CD at this moment.

Image File
This is only available in the registered version of PMC. By pressing the button you can 
choose an image. The filename can't be longer than eight caracters and the image has to be
of the Windows bitmap format. The images must be located in the same directory as the 
database they belong to. When an image is missing PMC won't prompt you it just can't show 
the image. You can give friends a copy of your database without the images. 

Remarks
Here you can enter some notes up to 256 caracters.

The tab Tracks
This tab contains the tracks on the album. If you click on the list to enter the data. If you 
can't enter the data chect the tab Details again.

The Track List
To enter the songs you must select the Soundcarrier and give the number of disks or tapes. 
It's also possible to insert more songs afterward if you want to. If you forgot a song then you 
can insert it between two other songs by pressing <SHIFT>-<INSERT>. To delete a song you 
can press <SHIFT>-<DELETE>. Use <TAB> to move to the next cell. When you don't want 
the automatic data to be entered use the arrow keys to move. When you are in the last 
column of the last row a new row will be added when you press <TAB>.



 Searching a record
Records                Printing Records                Exporting data
To look up a record click the Search button. A dialogbox will open where you can enter the 
searchstring and the field to search. The options Artist and Title are the fastest way to 
search the database. The other options are slower because PMC has to read from the disk for
these options. You can also enable search in deleted records if you want to. All records found
will be placed in the Search list and unless you check the Don't prompt box you get a prompt
for every matching record. When the search action is finished you can find all matching 
records in the Search List.

You can print the records that are gathered in the Search List.



 Printing Records
Records                Searching a record
Selecting a font for your printer
PMC enables you to select a font for your printer. To do so Select Printer Font in the File 
menu. All your installed fonts can be selected. The font size is limited to a range from 10 to 
14.

To install a font as default select Default Printer Font in the Options menu. Use Save Settings
to save it as default for later sessions.

Printing
You can print three different lists. 
· The first one is the whole list. To do so select the radiobutton Whole List    and check the 

data you want to be printed;
· The second option is to print a part of your list. To do so, you first have to search for 

records. Then you can choose Print and select Search List to print the records in the Search
List;

· The last option you can print is the Current Record. Select this option and check all data 
you want to be printed.

When you are not sure if whether the printer setup is correct or not, check it by clicking on 
the Setup button.

After you have made your choice click on the OK button.



 Exporting data
Records                Searching a record
You can export three different lists. 
· The first one is the whole list. To do so select the radiobutton Whole List;
· The second option is to print a part of your list. To do so, you first have to search for 

records. Then you can choose Export ASCII from the File menu and select Search List to 
export the records in the Search List;

· The last option you can print is the Current Record.

After you have chosen the list you want to be generated, select the directory and a file name
to export the data to.



 Playing a CD
Load Track Information
The CD player in PMC will only work properly    when you have both a CD-ROM and a 
soundcard. If one of these doesn't work properly PMC will prompt you with an error message 
when you start PMC and the CD display will say 'NOT READY'. To play a CD audio you must 
connect the audio cable between the CD-ROM and your soundcard properly. Otherwise it 
might look as if the CD is playing but you won't hear any music. 

You can play the CD by using the buttons beneath the display. Another option to play the CD 
is by double clicking on one of the tracks on the Track list. This will only work when you have
Loaded the Track Information from the CD itself.

When Windows own CD player takes over control you can disable it with Tweak UI in your 
control panel.
You can uncheck Play Audio CDs automaticly on the tab Paranoia.
If you don't have Tweak UI you can download if for free at serveral major FTP sites and 
Mircosoft.
Press the button to start Tweak UI now.

{button Switch off CD-player,EF(`tweakui.cpl',`Tweak UI',10)}



 Editing The Genrelist
To edit the Genrelist choose Edit Genrelist in the menu Options. You will see a window with 
the current genres in the list. You can insert new genres and delete genres the same way as 
in a normal editor. Every genre must be on a next line. The Genres will be shown in the order
you enter them. This enables you to place the Genre you need the most on top of the list.

It's best to keep the size of the Genrelist small by removing Genres you seldom or never use.



 Options

Purge Records At Close
When this option is checked all deleted records will be removed from the database when the
database is being closed.
Default: Not Checked.

Sort Records At Close
Checking this option means that all records will automaticly be sorted when you close the 
database.
Default: Checked.

Show Artists Of Each Song
When you check this option the option Show Artist Of Each Song will be checked by default.
Default: Not Checked.

Show Producer Or Composer Of Each Song
When you check this option the option Show Producer will be checked by default.
Default: Not Checked.

Use Producer As Default
Use Producer As Default will show the Producer field in the header. By clicking this option it 
this option will change to Use Componist As Default. In that case the field is used to enter 
the name of the componist.
Default: Use Producer As Default.

Convert First Letter Of Every Word To Caps
Checking this option will convert the first letter of every word you enter to a Capital.
Default: Not Checked.

Edit Genre List
With this option you can adjust the Genre List to your own needs.
The changes will be saved by clicking OK in the Gerne List Dialog box.

Sort By Artist And Album Title
Checking this option will sort the albums of one Artist by the title of the Albums in 
alphabethical order.
When you check this option Sort By Artist And Release Date will be unchecked.
Default: Checked.

Sort By Artist And Release Date
This option is the opposite of the option above. This time the albums of an artist will be 
sorted by release date. Checking this option wil uncheck Sort By Artist And Album Title.
Default: Not Checked.

Default Printer Font
Use this option to set your default Printer font. Don't forget to save it with save settings for 
use in future sessions.



Save Settings
This option is only available when changes to the options are made. Click on it to save the 
changes you've made for future sessions.



 License Information
Registering                Registration form
License
Private Music Collection Copyright    (c)1996-1997 ALTernative Productions. All Rights 
Reserved 

Private Music Collection will be called PMC through out this document.

License Agreement     
You should carefully read the following terms and conditions before using this software.    
Unless you have a different license agreement signed by ALTernative Productions. your use 
of this software you indicates your acceptance of this license agreement and warranty. 

Unregistered Use
You are allowed to try this software for 30 days. After that period you must stop using it or 
register it. When you register PMC all features will be enabled.
Use this evaluation period to see if you like the program and check if it works correctly on 
your system.
If you use this software after the evaluation period a registration fee of $25 is required. 
Payments must be in US dollars, German Marks or Dutch Guilders (Fl 30,-). Read Register to 
learn how to order and find a registration form. 

Unregistered use of PMC after the evaluation period is in violation of Dutch and international 
copyright laws. 

Registering
When you register you will recieve a temporary key that gives you 30 uncrippled starts. 
During that time you can try all options. After 21 days you will recieve your personal key. You
can enter it in the Help menu. During those 21 days you can do a back order. If you do not 
backorder within 21 days after registering, you agree that you have bought PMC and that 
you can't do a backorder anymore.

Registered Version     

Private use 
A registered version of PMC may be used on any computer inside your house. To be clear: 
You have to register once to use as many copies as you like on computers inside your own 
house for private use. 

Organisations, professionals and commercial use 
Organisations of any type or individuals using PMC for commercial purposes must register 
for each copy they want to use. You may access the registered version of PMC through a 
network, provided that you have obtained individual licenses for the software covering all 
workstations that will access the software through the network.    For instance, if 8 different 
workstations will access PMC on the network, each workstation must have its own PMC 
license, regardless of whether they use PMC at different times or concurrently. 

Governing Law 
This agreement shall be governed by the laws of the Netherlands. 

Disclaimer of Warranty 
This software and the accompanying files are sold "as is" and without warranties as to 
performance of merchantability or any other warranties wether expressed or implied.
Because of the various hardware and software environments into which PMC may be put, No 



warranty of fitness for a particular purpose is offered. Try the Shareware version before you 
register to be sure PMC works fine on your computer. If you like the program but find any 
problems contact me with as much details as you can give about when the problem occured 
(what were you doing at that moment) and your system. 

Good data processing procedure dictates that any program be thoroughly tested with non-
critical data before relying on it. The user must assume the entire risk of using the program. 
Any liability of the seller will be limited exclusively to product replacement or refund of the 
purchase price within the 21 days after registering. 

Distribution 
Provided that you verify that you are distributing the Shareware Version (select About from 
the Help menu to check) you are hereby licensed to make as many copies of the Shareware 
version of this software and documentation as you wish; give exact copies of the original 
Shareware version to anyone; and distribute the Shareware version of the software and 
documentation in its unmodified form via electronic means.    There is no charge for any of 
the above. It is NOT allowed to pass a (temporary) registration key or the file PMC.KEY 
through to others. 

You are specifically prohibited from charging, or requesting donations, for any such copies, 
however made; and from distributing the software and/or documentation with other products
(commercial or otherwise) without prior written permission. 



 Registering
License Information                Support
To use all abilities of PMC you have to regiser it. Basicly you can register in two ways:
with creditcard or without creditcard.
The price of one copy of PMC is US$ 25. To recieve the latest version on disk you have an 
additional US$ 10. To pay with international cheques you have to add US$ 5 for the extra 
costs. There are no extra costs for payment with Eurocheques. For creditcard orders US$ 10 
will be added to cover the handling costs.

As soon as I receive your payment and registration form I will send you a temporary key that
gives you 30 uncrippled starts. After 21 days you will receive your personal key. When you 
have got your personal key it is not possible to order your money back. This period is also 
needed for security reasons for payment through creditcard.

Contact the author if you have any questions.

Ordering with creditcard
Credit card orders are handled by the Public software Library.

PsL is a service that handles credit card orders for shareware programmers. Of course, this is
not a free service. This means that the costs of handling (US$ 10) the order are added to the
registration fee of US$ 25. This means that the registering price via PsL will become US$ 35.

If you place your credit card order now, as a bonus, you can save 80% on the latest PsL 
Shareware CD-ROM with thousands of the latest freeware and shareware programs for home
and office. The CD-ROM normally sells for $30 plus shipping, but when ordering Private 
Music Collection, you can get it for just $6 plus shipping with a full money-back satisfaction 
guarantee.

The best way to place your order, is to use PsL's secure registration page on the web. You 
can find the link on my home page at http://www.tomb.demon.nl

Alternatively, you can contact PsL by

· phone: +1-713-524-6394 Ext. 15242 
· fax: +1-713-524-6398 (please print your text, no handwriting)
· e-mail: 15242@pslweb.com
· snail-mail: PsL, P.O.Box 35705, Houston, TX 77235-5705 USA

Note that the above numbers are for placing credit card orders only. 
For support, questions and bug report contact the author . PsL can't help you with any 

questions. 
Address your questions about the registration key also to the author.

When placing your order, please mention the following details:

· PsL product ID: 15242 (This is even more important than the name Private Music 
Collection).

· Your name
· Your postal address
· Your email address (registration number is sent to this address)
· Credit card type and number, expiration date and the name on the card if it differs from 

your name mentioned above.
· The    username you want to register PMC to.



When your order is processed you will get the temporary key. After 21 days you will get your 
personal key from the author. For questions about the status of your key contact him.

Ordering without creditcard
When you are not able to pay through creditcard there are some other options to register.

First fill out the registarion form and send it to address stated below. The temporary key is 
send to you as soon as I receive a proper registration and payment. After 21 days you will 
get your personal key.

Payment
There are a few ways to pay:
The whole world:
· send enough cash (at your own risk) via snail mail (US$ 25);
· send a cheque payable to Arjan van de Logt account 33.12.67.381(extra costs US$ 5: US$ 

30 total price);

Europe:
· send an Eurocheque (in dutch currency) payable to Arjan van de Logt (no extra costs HFl 

30,00 total price);

The Netherlands:
· pay on bankaccount 33.12.67.381 Rabobank Kampen (HFl 30,00 total price).

Send the registarion form via E-mail to avdlogt@worldaccess.nl

Or print it and send it to:

Arjan van de Logt
Wilhelminalaan 44 
8262 DG Kampen
The Netherlands



 Registration form
License Information                Registering                Support
Private Music Collection Registration Form

NOTE: THIS IS THE REGISTRATION FORM FOR VERSION 1.21 IF THERE IS
A NEWER VERSION IT WILL BE SENT TO YOU TOGETHER WITH YOUR KEY.

Site licenses:    A site license for PMC entitles an organization
to receive one copy of the distribution package and to duplicate
the distribution disk for the specified number of copies.

PMC ____        copies at $25 / HFl 30 / DM 30 each = ___________
The latest version on disk $10 / HFl 10 / DM 10        = ___________

I pay
[ ] cash
[ ] International cheque (costs $5 extra to process) ___________
[ ] Eurocheque
[ ] to    Bankaccount 33.12.67.381 Rabobank Kampen (NL only)

Tatal Costs =___________

Name: ________________________________________________________________

Company: _____________________________________________________________

Address: ______________________________________________________________

City, State, Zip: _________________________________________________________

Country: _______________________________________________________________

Electronic Mail address: _________________________________________________

I agree that I get a temporary key for the first 21 days. During that period I can get my 
money back.
I agree that once I've got my personal key I can do no backorders anymore.
I understand that my order and payment won't be processed and nor returned when my 
order or payment is improper.

Date:______________ Sign:_____________________________________________



 Support
License Information                Registering                Known Problems

For questions, support, bug reports please contact me via E-mail at: avdlogt@worldaccess.nl

Please mention PMC with your version number in the subject line.
If you are not able to cantact me via E-mail you can snail mail me:

Arjan van de Logt
Wilhelminalaan 44
8262 DG Kampen
The Netherlands

Check out my homepage at http://www.tomb.demon.nl
 for the latest changes and updates.



 Known Problems
Support

I don't know how to save my data.
You don't have to save your data yourself. When you insert a new record, close PMC or start 
another action, the changed to the current record are saved automaticly.

Some options like printing are disabled.
You need to register PMC to be able to use all features.

I made a database using an older version of PMC, but I can't open it with this 
version.
To solve some problems with the database the database has changed. Some extra fields 
have been added also. Don't worry Your old database can be converted with pmcconv.exe. It 
has been installed to thew same directory as PMC.
Open your old database and it will be converted immediately. After that you can exit or open
another database to convert.
Use the button to start converting now.

{button PmcConv,EP("pmcconv.exe",0)}

I want to save my current settings but the menu option 'Save Settings' is 
disabled.
There can be two resons for this:
· You don't have a registered version of PMC
· The latest changes to your settings are already saved.

I get an error telling me there is not enough memory to start PMC's CD-player.
Some applications consume a lot of system resources. 
Resident video drivers to change display settings installed for the Diamond Stealth video 
cards are an example of this. 
Take a look at your system try (next to your clock) and shut down the applications your 
don't need. Insert a CD and press the Play button.
If there is enough memory free your CD will start to play now.

The Windows CD player starts up everytime I insert a new CD.
Windows Is configured to start the CD player as soon as a new Audio CD is inserted. You can 
turn it off with Tweak UI. Uncheck Play Audio CDs automaticly on the tab Paranoia.
If you don't have Tweak UI you can download if for free at serveral major FTP sites and 
Mircosoft.
Press the button to start Tweak UI now.

{button Switch off CD-player,EF(`tweakui.cpl',`Tweak UI',10)}

I'd like to add images of the CD cover, but I don't have a scanner.
Search on internet for a homepage about the band. Often you can find pictures of covers 
there. 
You can also try to trade pictures with other people.




